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Introduction to HTML Publishing 
The ProcessView Web Publishing Wizard enables you to "export" your GraphWorX (.gdf), 
TrendWorX (.t32), and AlarmWorX (.a32) displays to HTML files and/or publish the HTML files to a 
Web server (LAN or Internet). In publishing displays to a Web server, WebHMI uses HTML to 
reference the files in an Internet-enabled format. Once a display is "exported" to an HTML file and 
then published to a Web server, client machines can browse it through an Internet browser, such as 
Microsoft Internet Explorer or Netscape Navigator. Each display can be viewed as a Web page. 
Note: Netscape Navigator generally does not support ActiveX technology. Smar has solved this 
problem by supplementing Netscape with a plug-in. Acting as a bridge, this plug-in allows for an 
ActiveX component to be put into the special Netscape module.  

Basic Steps in Publishing GraphWorX Displays  
Publishing a GraphWorX display to HTML involves the following basic steps: 

1. Create a GraphWorX display (.gdf) file on a developer workstation with GraphWorX installed. 

2. Use the Web Publishing Wizard to generate an HTML file and publish the file to a Web server 
(URL) address.  

3. On the Web server PC (with ProcessView installed), start GenBroker Server from ProcessView 
Tray. 

4. On a client PC, open a Web browser, such as Microsoft Internet Explorer, and browse to the 
URL address of the HTML file. The client PC downloads the HTML file from the Web server. The 
Web server delivers all the necessary components (e.g. ActiveX controls) to the client PC's Web 
browser, which then runs the GraphWorX display directly within the browser. This way you can 
view the GraphWorX display in real time as a Web page. 

The source code of the published HTML file contains references to the required “plug-ins” that are 
needed to deliver the GraphWorX Viewer ActiveX control to the client. The GraphWorX Viewer 
ActiveX is needed to run the .gdf file over the network. The GraphWorX display itself is not really 
“converted” into HTML. Instead the display (.gdf) file is referenced in the HTML code by the ActiveX 
plug-in.  
To expand on step 2 above, the following Microsoft Internet Explorer example shows the portion of 
the generated HTML source code that references the .gdf file.  The GWXview32.cab file is 
referenced in the codeBase field to deliver the “plug-in” for the GraphWorX Viewer ActiveX.  This in 
turn opens up the .gdf display.  In the example below, the .gdf display file is called Building1.gdf, 
as shown below in the DisplayName parameter field. 
<OBJECT classid=clsid:98A5DDE3-563B-11CF-A343-487C03C10000  
codeBase="http://www.myserver.com/webhmi/cabs/GWXview32.cab"  
id=GWXview321 style="HEIGHT: 420px; WIDTH: 620px" height=420 width=620> 
<param name="_Version" value="65537"> 
<param name="_ExtentX" value="16404"> 
<param name="_ExtentY" value="11113"> 
<param name="_StockProps" value="160"> 
<param name="BorderStyle" value="1"> 
<param name="Appearance" value="1"> 
<param name="DisplayName" value="http://www.myserver.com/webhmi/Building1.gdf"> 
<param name="UseAmbientBackColor" value="0"> 
<param name="AutoStartRuntime" value="-1"> 
<param name="OverrideScrollbarSettings" value="1"> 
<param name="VerticalScrollbar" value="0"> 
<param name="HorizontalScrollbar" value="0"> 
</OBJECT> 
Exporting a .gdf file to an HTML file not only references the GWXview32.cab file, as shown in the 
example above, but also references any other "plug-in" .cab files required for other ActiveX 
components that may be embedded within the .gdf file (e.g., TrendWorX or AlarmWorX Viewer 
ActiveX controls). 
However, before a .gdf file can communicate with live OPC data, the IcoSetServer.cab file “plug-
in,” which is necessary for security and licensing, as well as a GenBroker configuration (.gbc or 
.gbx) file, which contains network configuration settings for OPC communications, must also be 
delivered to the client PC. The IcoSetServer.cab file and the .gbc or .gbx file are referenced in the 
HTML source code. This way the security and licensing information are available whenever a 
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component (such as an Alarm Viewer ActiveX) is downloaded. The sample HTML source code 
below shows how these files are referenced in the code.  
<object id="SetServer2" classid="clsid:57802C16-9A15-11D4-B2A8-0090272E599B" 
codeBase=http://www.myserver.com/WebHMI/cabs/IcoSetServer.cab height=28 width=17> 
    <PARAM NAME="CfgName" 
VALUE="http://www.myserver.com/WebHMI/Samples/Default.gbc"> 
</object> 
The ProcessView Web Publishing Wizard in GraphWorX takes care of all the necessary HTML code 
references automatically. Microsoft Internet Explorer uses .cab files, whereas Netscape Navigator 
uses .dpl files. 
Note: If you are using multiple frames for your WebHMI pages (e.g. a main "navigation" frame for 
browsing between pages, and a "content" frame that contains the body of the pages), make sure 
that the IcoSetServer.cab file and the .gbc or .gbx file are properly referenced in the HTML source 
code for the main frame. This way the security and licensing information are available whenever a 
component is downloaded. 

Delivering the Necessary Web Components to the Client 
WebHMI is designed to operate with Zero Install and Thin Client philosophy. This means the client 
PC has nothing but Windows, Internet Explorer, or Netscape loaded. Thus, all necessary Web 
components must be remotely delivered and seamlessly installed. The type and number of 
components required for delivery on the client PC are determined by the content of the GraphWorX 
displays. For instance, a display with an embedded Trend Viewer requires delivery of the 
corresponding TrendWorX Viewer ActiveX Web component, but not the AlarmWorX Viewer ActiveX. 
On the other hand, a display with an embedded Alarm Viewer requires the corresponding 
AlarmWorX Viewer ActiveX but not the TrendWorX Viewer ActiveX. 
The delivery process can be very slow in terms of network speed. To avoid wasting time, the first 
requirement is to deliver only the required component. The delivery process is strictly connected to 
the HTML code. Inside the HTML code, there are references to .dpl files or .cab files, the basic ways 
to deliver components. As a result, the building of the HTML page is a critical step. The Web 
Publishing Wizard looks inside the display to understand what components are needed on the client 
side and then builds the corresponding HTML code. 
Netscape Navigator and Microsoft Internet Explorer neither process the HTML code in the same 
way nor deliver the component in the same standard format.  Basically, Microsoft Internet Explorer 
requires components to be delivered using .cab file technology whereas Netscape Navigator 
requires .dpl files. 

Client Station Requirement 
In order to view a published GraphWorX display, a client PC must have a Web browser installed 
(e.g. Microsoft Internet Explorer or Netscape Navigator). 

Developer Station Requirement 
The developer station requires GraphWorX Version 6.1 or greater. 

Web Server Station Requirement 
The Web server PC must have the following installed: 

• WebHMI 

• ProcessView (with GenBroker) 

• For Windows NT, Internet Information Server (IIS) or a Personal Web Server 

• For Windows 2000 and Windows XP, Internet Information Server (IIS) 
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Multiple Display Support 
Suppose that you have a main GraphWorX display (.gdf) file that is linked to other display files (e.g. 
each display contains pick actions, such as Load Display or Pop-up Window, that point to the other 
display files). When you publish the main display to an HTML file, you want all the links and 
references to the other dependent display files to be functional when the HTML file is downloaded to 
a client Web browser. The Web Publishing Wizard makes this possible by detecting all mutually 
linked display files, looping through all dynamic actions, and checking for pick actions in which a file 
name is specified as one of its parameters. The following pick actions are supported for multiple 
GraphWorX display Web publishing support: 

• Load Display 

• Embedded Window 

• Popup Window 

• Drag/Drop Load 

• Set Aliases 
• Alias Dialog (alias files specified through the Set Aliases dialog box in GraphWorX). 
 
The LoadTabs display property is also supported for publishing multiple GraphWorX displays. 

Embedded ActiveX Control Support 
In dealing with a main GraphWorX display (.gdf) file that is linked to other display files (as described 
in the "Multiple Display Support" section above), suppose you included an ActiveX Control (e.g. 
Alarm Viewer ActiveX or Trend Viewer ActiveX) into each of the dependent display files. Also 
suppose that you generated and published an HTML file only from the main display, but you want 
this single HTML file to trigger the simultaneous download and installation of all ActiveX Controls 
embedded within all interlinked GraphWorX display files. The Web Publishing Wizard's embedded 
ActiveX Control support makes this possible, allowing you to view the ActiveX Controls in all 
displays from a single client Web browser. 

Using the Web Publishing Wizard 
The Web Publishing Wizard performs two basic operations: 

1. The Wizard creates an HTML file based on a user-specified GraphWorX display (.gdf) file, 
TrendWorX display (.t32) file, or AlarmWorX display (.a32 file). 

2. The Wizard then either "exports" (saves) the HTML file to a user-specified directory on the local 
drive and/or "publishes" (uploads) the HTML file to a user-specified Web server URL address 
(i.e. over the Internet or an intranet). 

Starting the Web Publishing Wizard 
To launch the Web Publishing Wizard in GraphWorX:  

1. Load or create a GraphWorX display (.gdf) file. 

2. After you have either created a new display file or opened an existing file, select Save As from 
the File menu. The Save As dialog box opens, allowing you to specify the name and location of 
the file you are about to save. Type a name for the new file in the File Name field.  It is important 
that, when saving your file, you select "GraphWorX Displays without VBA (*.gdf)" in the Save as 
Type field, as shown in the figure below, because the Web Publishing Wizard does not support 
Microsoft Visual Basic for Applications (VBA). Click the Save button to save the current file. 
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Saving the Display As a Non-VBA File 

3. Select Publish to HTML from the Tools menu, as shown in the figure below. 

 
Starting the Web Publishing Wizard in GraphWorX 

Note: If you try to run the Web Publishing Wizard with a GraphWorX display with VBA, you will get a 
warning message as shown in the figure below. If you click Yes, the Web Publishing Wizard 
automatically saves the display as a non-VBA file. If you click No, the publishing operation is 
cancelled. 

 
Warning Message About Displays With VBA 

4. This launches the Web Publishing Wizard configuration dialog box, as shown in the figure 
below. This dialog box serves as the interface through which you export/publish GraphWorX 
display files to the Web. 
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Note: Both the Publish to Web Server and Export Local Copy actions can be performed at the 
same time. 

 
Web Publishing Wizard Dialog Box 

Exporting a Display File Locally 
To export a GraphWorX display to a directory on the local drive: 

1. In the Based on Source File field of the Web Publishing Wizard, you must specify the name of 
the GraphWorX display (.gdf) file to be exported, as shown in the figure below. To choose a 
different display, click the … button to the right to browse for a file. Select a file and then click 
Open. The directory path and the file name are shown in the text field.  

 
Specifying a GraphWorX Display File 
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2. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created. The .gdf file name is filled in by default, but you can give the HTML file a 
different name.  

3. In the Publishing Options field, check the Export Local Copy check box and specify the local 
directory path name to which you want to export the HTML file. You can select a recently used 
path from the drop-down list, or click the … button to browse for a destination directory, as 
shown in the figure below. Select the directory and click OK.  

 
Setting the Local Directory 

4. The local directory pathway you selected appears in the Export Local Copy field of the Web 
Publishing Wizard, as shown in the figure below. 

 
Export Local Copy Pathway Shown in the Wizard 

5. Click the OK button to generate the HTML file. The new HTML file is saved to the local directory 
pathway specified in the Export Local Copy field. 

Note: Both the Publish to Web Server and Export Local Copy actions can be performed at the 
same time. 
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Publishing a Display File to a Web Server 
To publish the HTML file to a directory on a Web server (i.e. over the Internet or an intranet): 

1. In the Based on Source File field of the Web Publishing Wizard, you must specify the name of 
the GraphWorX display (.gdf) file to be published, as shown in the figure below. To choose a 
different display, click the … button to the right to browse for a file. Select a file and then click Open. 
The directory path and the file name are shown in the text field. 

 
Specifying a GraphWorX Display File 

2. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created. The .gdf file name is filled in by default, but you can give the HTML file a 
different name.  

3. In the Publishing Options field, check the Publish to Web Server check box and type in the 
URL address of your Web server with the complete directory indicating where you want to 
publish the HTML file, as shown in the figure below. In the sample Web server URL address 
shown below ("http://www.myserver.com/WebHMI/Samples"), the various components are: 
• http://www.myserver.com: IP address (server name) of the WebHMI Server 

• WebHMI: Name of the WebHMI server root directory  

• Samples: Name of the directory on the server to which the HTML file will be saved 

4. The Web server URL address now appears in the Web Publishing Wizard dialog box in the 
Publish to Web Server field of the Web Publishing Wizard, as shown in the figure below. 
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Publish to Web Server Location Specified in Web Publishing Wizard 

5. Click the OK button to generate the HTML file. The new HTML file is uploaded to the Web server 
and then saved to the URL address path specified in the Publish to Web Server field. 

Note: Both the Publish to Web Server and Export Local Copy actions can be performed at the 
same time. 

Publishing Customization Options 
The Web Publishing Wizard contains some customization options for exporting/publishing HTML 
files. Clicking the Advanced button on the Web Publishing Wizard dialog opens the Web 
Publishing Properties dialog box, as shown in the figure below, which contains the following tabs: 
• Server Switching Support 

• Screen Resolution Settings 

• Publishing Options 

Server Switching Support 
The Server Switching Support tab of the Web Publishing Properties dialog box, shown in the 
figure below, allows you to enable or disable GenBroker support for the exported/published HTML 
file. Here you can specify which GenBroker configuration file (.gbc or .gbx) will be activated. The 
GenBroker configuration file establishes the settings for OPC data communications between the 
clients and the Web server.  



Web Publishing Wizard 

9 

 
Server Switching Support Settings 

There are three available options for GenBroker support: 
• None: GenBroker support is not active. 
• As Configured in WebHMI Settings: This setting uses the default URL address of the 

GenBroker configuration (.gbc or .gbx) file as specified in the WebHMI installation. 

• User Defined: When this option is selected, the GenBroker Configuration File URL field 
becomes available, allowing you to specify the URL address of the GenBroker configuration 
(.gbc or .gbx) file.  

 
Clients can receive data from different WebHMI servers, but communication can be established only 
to one server at a time. The server to which a client connects depends on the type of information 
that the client requests. If Server A, for example, does not contain the components necessary to 
answer the client's request, the request will be forwarded to Server B, or Server C, and so on. 
Note: For information about configuring GenBroker settings, please see the GenBroker Configurator 
Help documentation. 

Screen Resolution Settings 
The Screen Resolution tab of the Web Publishing Properties dialog box, shown in the figure 
below, determines the screen resolution and size of the GraphWorX Viewer ActiveX control, which 
is referenced in the generated HTML file and then downloaded to a client PC when the HTML file is 
viewed in the client's Web browser.  You can specify the screen size in the Width and Height fields 
in terms of pixels (px) or percentage (%). Click the Resolutions button to select from a pop-up 
menu of standard screen resolutions, as shown in the figure below. 

 
Screen Resolution Settings 
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Publishing Options 
The Publishing Options tab of the Web Publishing Properties dialog box, shown in the figure 
below, enhances the publishing process. By default, the Web Publishing Wizard provides support 
for related files detection (for more details, see the Multiple Display Support section). The multiple 
display detection could be a rather lengthy process. You can speed up the process by disabling the 
Enable Multiple Display Support option. This is especially useful, if you have already published 
your project files to the Web server, and now you want to update display you have changed.  
The multiple display detection mechanism ensures that the Web page will be published properly for 
the source file. Disabling the Multiple Display Support may cause publishing of an incomplete web 
page, which may result in unexpected behavior. Therefore, it is suggested to disallow publishing of 
the Web page. You can do so by enabling the Publish Display File Only option. 

 
Publishing Options 

Viewing Locally Exported HTML Files 
To view an HTML file that was exported to a local directory, simply browse to the local directory 
pathway and click on the file to open it in your Web browser. You can also open your Web browser 
and copy the directory pathway of the file into the Address field of the Web browser, as shown in 
the figure below. A complete directory path is, for example, "C:\Documents and 
Settings\Administrator\My Documents\Web Publishing Example\ChemFood_BeanRoaster.htm." Be 
sure to include the name of the HTML file that you have exported and the file extension "htm." 

 
Viewing the Exported HTML File in a Web Browser 

Viewing Published HTML Files 
Before a published HTML file can be downloaded from a WebHMI server, you must set GenBroker 
active on the WebHMI server node using ProcViewTray: 

1. Launch ProcViewTray from the Windows Start menu by selecting Programs > Smar 
ProcessView > Tools > ProcessView Tray. 
2. When ProcViewTray opens, the triangle icon will appear in the Windows tool tray. Click on the 
triangle and select GenBroker > Start from the pop-up menu, as shown in the figure below. This 
activates the GenBroker Server. 
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Starting the GenBroker Server on the Server Node 

3. Once the GenBroker Server is running, you can view the HTML file that you have published to 
the Web server from any client PC's Web browser. To view the published HTML file, open your Web 
browser and copy the URL address of the file into the Address field of the Web browser, as shown 
in the figure below. A complete address is, for example, 
"http://www.myserver.com/webhmi/Samples/ChemFood_BeanRoaster.htm." Be sure to include the 
name of the HTML file that you have published and the "htm" file extension. The GraphWorX display 
file is referenced in the HTML code so the display can be viewed as a Web page. The client's Web 
browser simply downloads the HTML file in which the .gdf file is referenced. All the client needs is a 
Web browser; it is not necessary to have ProcessView installed on client. The Web page is 
downloaded from the Web server across the Internet/intranet and appears in the client's Web 
browser window. The display is real-time, just as if you were viewing the runtime display in 
GraphWorX on the server machine; the OPC tag values change dynamically in the display. 

 
Viewing the Published HTML File in a Client Web Browser 

Web Publishing in ProjectWorX 
The Web Publishing Wizard can be accessed through ProjectWorX console, allowing you to easily 
export/publish one or more GraphWorX display files within a project to a Web server. As shown in 
the figure below, the Applications/GraphWorX/Displays tree of each project includes an option to 
publish a single display or multiple displays in the project.  

 
Publishing GraphWorX Displays From the ProjectWorX Console 
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The WebHMI tree under the Applications tree for each project in the ProjectWorX console, shown 
in the figure below, manages Web publishing for the entire project. From here you can right-click 
and publish HTML files to a Web server. The WebHMI tree includes the following three categories: 

• GraphWorX-Based HTML 

• Local HTML Files 

• Published Documents 

 

 
WebHMI Tree in ProjectWorX Console 

GraphWorX-Based HTML 
The GraphWorX-Based HTML subtree of the WebHMI tree, shown in the figure below, contains 
HTML files generated from exported GraphWorX displays. These HTML files have embedded code 
for accommodating a GraphWorX Viewer ActiveX Control.  Any requested local copy of a 
GraphWorX-based HTML file generated from the Web Publishing Wizard is stored in this folder.  
(See the “Web Publishing Wizard” section below for more information on exporting and publishing 
HTML files from GraphWorX displays.)  The ProjectWorX database maintains a record of which 
local GraphWorX display (.gdf) files each of these HTML files depends on.  Documents in this folder 
can be added, removed, copied, pasted, opened, edited, added to Microsoft Visual SourceSafe, 
searched, replaced, and packed the same way items from other categories can. 

 
GraphWorX-Based HTML Subtree 
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Local HTML Files 
The Local HTML Files subtree of the WebHMI tree stores basic HTML files that were not generated 
from the Web Publishing Wizard.  Here you can add, delete, edit, and maintain various HTML files.  

 
Local HTML Files Subtree 

Published Documents 
The Published Documents subtree of the WebHMI tree, shown in the figure below, maintains a list 
of all HTML files that have been exported/published from ProjectWorX.   

 
Published Documents Subtree 

In the right-hand pane of the ProjectWorX Console, each item is listed as a URL with the date it was 
published, as shown in the figure below. For information about publishing files from ProjectWorX, 
please see "Using the Web Publishing Wizard." 

 
List of All Documents Published From ProjectWorX 

Launching the Web Publishing Wizard in ProjectWorX 
The Web Publishing Wizard in ProjectWorX performs two basic operations: 

1. The Wizard creates HTML files based user-specified GraphWorX display (.gdf) files. 

2. The Wizard then either "exports" (saves) the HTML files to a user-specified directory on the 
local drive and/ or "publishes" (uploads) the HTML file to a user-specified Web server URL address 
(i.e. over the Internet or an intranet). 
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Web Publishing Wizard in ProjectWorX Console 

You can open the Web Publishing Wizard dialog from the ProjectWorX console in the following 
ways: 

• Select the project root and then choose Publish Wizard from the Tools menu, as shown in the 
figure below. In this case, both the Publish Web Page field and the Based on Source File field in 
the Web Publishing Wizard dialog are read-only and contain the text “(Display Name).htm” and “(All 
GraphWorX Displays in Project),” respectively.  The browse (…) button is also disabled. 

 
Opening the Publishing Wizard From the Tools Menu 

• Right-click on the Applications/GraphWorX/Displays tree and select Publish All Displays, 
as shown in the figure below.  In this case, both the Publish Web Page field and the Based on 
Source File field in the Web Publishing Wizard dialog are read-only and contain the text “(Display 
Name).htm” and “(All GraphWorX Displays in Project),” respectively.  The browse (…) button is also 
disabled. 
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Publishing All GraphWorX Displays in a Project 

• Right-click on a GraphWorX display and select Publish HTML, as shown in the figure below. In 
this case, the Based on Source field in the Web Publishing Wizard dialog is read-only and contains 
the name of the selected GraphWorX display.  The browse (…) button is also disabled. 

 
Publishing a GraphWorX Display File 

• Right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select New 
HTML Document, as shown in the figure below.  In this case, you need to specify a GraphWorX 
display file in the Based on Source File field by browsing for the file or by typing in the file name. 
You also need to specify the name of the new HTML file in the Publish Web Page field. 

 
Creating a New HTML File in a Project 
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Export and Publish Options in ProjectWorX 
The Web Publishing Wizard in the ProjectWorX console, shown in the figure below, generates an 
HTML file based on one or more user-specified GraphWorX display (.gdf) files. Then the Wizard 
either "exports" (saves) the HTML file to a user-specified directory on the local drive or "publishes" 
(uploads) the HTML file to a user-specified Web server URL address (i.e. over the Internet or an 
intranet).  
You have the following options when using the Web Publishing Wizard for a project: 
• Export and/or publish all GraphWorX display files in the project. 

• Export and/or publish a single GraphWorX display file in the project. 

• Export a display file locally 

• Publish a display file to a Web server. 
 
Note: Both the Publish to Web Server and Export Local Copy actions can be performed at the 
same time. 

 
Web Publishing Wizard in ProjectWorX Console 
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Exporting and Publishing Multiple GraphWorX Display Files in ProjectWorX 
In ProjectWorX, you can export and/or publish multiple GraphWorX display files using the Web 
Publishing Wizard. 
To export/publish all displays in a project: 

1. Select the project root and then choose Publish Wizard from the Tools menu, or right-click on 
the Applications/GraphWorX/Displays tree and select Publish All Displays, as shown in the 
figure below. 

 
Launching the Web Publishing Wizard 

2. This launches the Web Publishing Wizard, as shown in the figure below. In this case, both the 
Publish Web Page field and the Based on Source File field in the Web Publishing Wizard 
dialog are read-only and contain the text “(Display Name).htm” and “(All GraphWorX Displays in 
Project),” respectively.  The browse (…) button is also disabled. 

 
Publishing All GraphWorX Displays in a Project 
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Exporting and Publishing Individual GraphWorX Display Files in ProjectWorX 
In ProjectWorX, you can export and/or publish individual GraphWorX display files using the Web 
Publishing Wizard.  
To export/publish a single display in a project: 

1. Right-click on a GraphWorX display and select Publish HTML, as shown in the figure below.  

 
Launching the Web Publishing Wizard 

2. This launches the Web Publishing Wizard, as shown in the figure below. In this case, the Based 
on Source File field in the Web Publishing Wizard dialog is read-only and contains the name of the 
selected GraphWorX display.  The browse (…) button is also disabled.  

3. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created. The .gdf file name is filled in by default, but you can give the HTML file a 
different name. 

 
Publishing a GraphWorX Display in a Project 

Note: You can also right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and 
select New HTML Document, as shown in the figure below, to export/publish a GraphWorX display.  
This launches the Web Publishing Wizard. In this case, you need to specify a GraphWorX display 
file in the Based on Source File field by browsing for the file or by typing in the file name. You also 
need to specify the name of the new HTML file in the Publish Web Page field. 
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Creating a New HTML File in a Project 

 

Exporting a Display File Locally in ProjectWorX 
To export a GraphWorX display to a directory on the local drive: 

1. Right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select New 
HTML Document, as shown in the figure below.  

 
Launching the Web Publishing Wizard 

2. This launches the Web Publishing Wizard, as shown in the figure below. In the Based on 
Source File field of the Web Publishing Wizard, you must specify the name of the GraphWorX 
display (.gdf) file to be exported, as shown in the figure below. To choose a display, click the … 
button to the right to browse for a file. Select a file and then click Open. The directory path and the 
file name are shown in the text field.  

 
Exporting a Display File Locally in ProjectWorX 
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3. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created.  

4. In the Publishing Options field, the Export Local Copy check box is checked by default. 
Specify the local directory path name to which you want to export the HTML file. You can select 
a recently used path from the drop-down list, or click the … button to browse for a destination 
directory. Select the directory and click OK. The local directory pathway you selected appears in 
the Export Local Copy field of the Web Publishing Wizard.  

Note: By default, ProjectWorX saves the HTML file to the (local) 
Applications/WebHMI/GraphWorX-Based HTML tree. From there, the HTML file can be edited 
and published again in the future.   

5. Click the OK button to generate the HTML file. The new HTML file is saved to the local directory 
pathway specified in the Export Local Copy field. 

Note: Both the Publish to Web Server and Export Local Copy actions can be performed at the 
same time. 

Publishing a Display File to a Web Server in ProjectWorX 
To publish the HTML file to a directory on a Web server (i.e. over the Internet or an intranet): 

1. Right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select New 
HTML Document, as shown in the figure below.  

 
Launching the Web Publishing Wizard 

2. This launches the Web Publishing Wizard, as shown in the figure below. In the Based on 
Source File field of the Web Publishing Wizard, you must specify the name of the GraphWorX 
display (.gdf) file to be published, as shown in the figure below. To choose a display, click the … 
button to the right to browse for a file. Select a file and then click Open. The directory path and 
the file name are shown in the text field.  
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Publishing a Display File to a Web Server 

3. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
that will be created.  

4. In the Publishing Options field, check the Publish to Web Server check box and type in the 
URL address of your Web server with the complete directory indicating where you want to 
publish the HTML file, as shown in the figure above. In the sample Web server URL address 
shown above ("http://www.myserver.com/WebHMI/Samples"), the various components are: 
• http://www.myserver.com: IP address (server name) of the WebHMI Server 

• WebHMI: Name of the WebHMI server root directory  

• Samples: Name of the directory on the server to which the HTML file will be saved 

5. Click the OK button to generate the HTML file. The new HTML file is uploaded to the Web server 
and then saved to the URL address path specified in the Publish to Web Server field. 

Note: By default, ProjectWorX also saves the HTML file to the (local) 
Applications/WebHMI/GraphWorX-Based HTML tree. From there, the HTML file can be edited 
and published again in the future.   
Note: Both the Publish to Web Server and Export Local Copy actions can be performed at the 
same time. 

Publishing Customization Options 
The Web Publishing Wizard contains some customization options for exporting/publishing HTML 
files. Clicking the Advanced button on the Web Publishing Wizard dialog opens the Web 
Publishing Properties dialog box, which contains the following tabs: 
• Server Switching Support 

• Screen Resolution Settings 

• Publishing Options 

 

Server Switching Support 
The Server Switching Support tab of the Web Publishing Properties dialog box, shown in the 
figure below, allows you to enable or disable GenBroker support for the exported/published HTML 
file. Here you can specify which GenBroker configuration file (.gbc or .gbx) will be activated. The 
GenBroker configuration file establishes the settings for OPC data communications between the 
clients and the Web server.  



ProcessView 

22 

 
Server Switching Support Settings 

There are three available options for GenBroker support: 
• None: GenBroker support is not active. 

• As Configured in WebHMI Settings: This setting uses the default URL address of the 
GenBroker configuration (.gbc) file as specified in the WebHMI installation. 

• User Defined: When this option is selected, the GenBroker Configuration File URL field 
becomes available, allowing you to specify the URL address of the GenBroker configuration 
(.gbc or .gbx) file.  

 
Clients can receive data from different WebHMI servers, but communication can be established only 
to one server at a time. The server to which a client connects depends on the type of information 
that the client requests. If Server A, for example, does not contain the components necessary to 
answer the client's request, the request will be forwarded to Server B, or Server C, and so on. 
Note: For information about configuring GenBroker settings, please see the GenBroker Configurator 
Help documentation. 

 
Screen Resolution Settings 

The Screen Resolution tab of the Web Publishing Properties dialog box, shown in the figure 
below, determines the screen resolution and size of the GraphWorX Viewer ActiveX control, which 
is referenced in the generated HTML file and then downloaded to a client PC when the HTML file is 
viewed in the client's Web browser.  You can specify the screen size in the Width and Height fields 
in terms of pixels (px) or percentage (%). Click the Resolutions button to select from a pop-up 
menu of standard screen resolutions, as shown in the figure below. 

 
Screen Resolution Settings 
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Publishing Options 
The Publishing Options tab of the Web Publishing Properties dialog box, shown in the figure 
below, enhances the publishing process. By default, the Web Publishing Wizard provides support 
for related files detection (for more details, see the Multiple Display Support section). The multiple 
display detection could be a rather lengthy process. You can speed up the process by disabling the 
Enable Multiple Display Support option. This is especially useful, if you have already published 
your project files to the Web server, and now you want to update display you have changed.  
The multiple display detection mechanism ensures that the Web page will be published properly for 
the source file. Disabling the Multiple Display Support may cause publishing of an incomplete web 
page, which may result in unexpected behavior. Therefore, it is suggested to disallow publishing of 
the Web page. You can do so by enabling the Publish Display File Only option. 

 
Publishing Options 

Publishing Files at a Later Time 
The Web Publishing Wizard, ProjectWorX saves the generated HTML file to the (local) 
Applications/WebHMI/GraphWorX-Based HTML tree. The advantage of storing a local copy of an 
exported HTML file is that it can be edited, packed, moved, unpacked, and then published again at 
any time. This saves you the burden of having to re-export the same GraphWorX display file to a 
new HTML file.  You can use this option in any of the following ways: 

• Right-click on any HTML file in the Applications/WebHMI/GraphWorX-Based HTML tree and 
select Publish HTML from the pop-up menu, as shown in the figure below. 

• Right-click on any HTML file in the Applications/WebHMI/Local HTML Files tree and select 
Publish HTML from the pop-up menu.  

 Note: Selecting Edit HTML from the pop-up menu opens the source code for the HTML file. 

 
Publishing a Locally Stored HTML File  
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• Right-click on the GraphWorX-Based HTML Files tree and select Publish All Files from the 
pop-up menu, as shown in the figure below. 

• Right-click on the Local HTML Files tree and select Publish All Files from the pop-up menu. 

• Right-click on the WebHMI tree and select Publish All Files from the pop-up menu. This 
publishes all HTML files in the WebHMI tree. 

 
Publishing All Locally Stored HTML Files 

All of these actions open the Publish HTML File to Web Site dialog box, as shown in the figure 
below. The Qualified WWW Folder field in this dialog is identical to the Publish Location field in 
the Web Publishing Wizard dialog and is stored in the same place in the registry if the action is 
successful. This specifies the location of the Web server to which the HTML file will be published. If 
the export/publish action is successful, a "publish” action on an HTML file in the Local HTML Files 
tree simply uploads the HTML file to the Web server.  A “publish” action on an HTML file in the 
GraphWorX-Based HTML Files tree uploads both the HTML file and its attached GraphWorX 
display (.gdf) file to the Web server. 

 
Specifying a Web Server Location for HTML Publishing 

Web Publishing Log 
When exporting/publishing only one file from a GraphWorX display to HTML, you are alerted if 
anything goes wrong in the process. If, however, multiple files are being exported/published 
simultaneously, a log is generated so the operation will not be halted with each file that cannot be 
exported/published.  After a batch publishing operation from the GraphWorX-Based HTML Files 
tree, a log file appears showing the success or failure of each attempt to publish the files.  If this log 
file is needed at a later time, it can be found in the project root, as shown in the figure below. 

 
Location of Web Publishing Log File 

 


